The KolourPaint Handbook

Thurston Dang
Clarence Dang
Lauri Watts
Contents

1 Introduction 6

2 Using KolourPaint 7

3 Tools 8
   3.1 Acquiring Screenshots ................................................................. 8
   3.2 Tool Reference .............................................................................. 8
   3.3 Brush ........................................................................................... 9
   3.4 Color Picker ............................................................................... 10
   3.5 Connected Lines and Polygon ...................................................... 10
   3.6 Curve ......................................................................................... 10
   3.7 Ellipse ......................................................................................... 10
   3.8 Erasers ....................................................................................... 10
      3.8.1 Eraser .................................................................................. 10
      3.8.2 Color Eraser ........................................................................ 11
   3.9 Flood Fill .................................................................................... 11
   3.10 Line ........................................................................................... 11
   3.11 Pen ............................................................................................ 12
   3.12 Rectangles ............................................................................... 12
   3.13 Selections ............................................................................... 12
   3.14 Spraycan .................................................................................. 13
   3.15 Text .......................................................................................... 13
      3.15.1 Using the Transparent Color .................................................. 14
   3.16 Common Tool Options ............................................................... 14

4 Working with Color 16
   4.1 The Color Box ............................................................................ 16

5 View Options 17
   5.1 View Options Reference ............................................................... 17
   5.2 Zoom incorporating the Grid ...................................................... 17
   5.3 Thumbnail .................................................................................. 18
6 Image Effects

6.1 Image Effects Reference ................................................................. 19
6.2 Autocrop / Remove Internal Border .................................................. 19
6.3 Balance ......................................................................................... 20
6.4 Clear ............................................................................................ 20
6.5 Emboss ......................................................................................... 20
6.6 Flatten ......................................................................................... 21
6.7 Flip (upside down) ......................................................................... 22
6.8 Invert ............................................................................................ 22
6.9 Mirror (horizontally) ...................................................................... 22
6.10 Reduce Colors .............................................................................. 22
6.11 Reduce to Grayscale ..................................................................... 23
6.12 Reduce to Monochrome (Dithered) .................................................. 23
6.13 Resize / Scale .............................................................................. 24
6.14 Rotate .......................................................................................... 25
6.15 Set as Image (Crop) ...................................................................... 25
6.16 Skew ........................................................................................... 26
6.17 Soften & Sharpen ........................................................................ 26
6.18 More Effects ................................................................................. 27
6.19 Notes ............................................................................................ 27

7 Credits and License ............................................................................ 29
Abstract

KolourPaint is a free, easy-to-use paint program by KDE.
Chapter 1

Introduction

KolourPaint is a free, easy-to-use paint program by KDE. It’s perfect for everyday tasks such as:

- Painting - drawing diagrams and ‘finger painting’
- Manipulating Screenshots - acquiring and editing screenshots
- Image Manipulation - editing photos and acquired images; applying effects
- Icon Editing - drawing clipart and logos with transparency

![KolourPaint Interface](image-url)
Chapter 2

Using KolourPaint

Click on the following links to explore KolourPaint’s capabilities:

- Tools
- Working with Color
- View Options
- Image Effects
Chapter 3

Tools

An additional option in the Settings menu allows to define if the tools draw with anti-aliasing (default) or not.

3.1 Acquiring Screenshots

A ‘screenshot’ is a snapshot of what is on your computer’s screen. It can be useful to explain some actions that should be done to obtain the result, or to show the issue that you have found.

To make screenshot ready for editing in KolourPaint window you can use File → Acquire Screenshot item from KolourPaint main menu.

Using the opened dialog you can change Screenshot Delay (in seconds), and choose to Hide Main Window during screenshoting. When you are ready to take screenshot just click OK. The screenshot taken will be placed directly into the KolourPaint editing area.

3.2 Tool Reference

A quick way to select a tool in KolourPaint is to press the single key shortcut associated with it, documented below and in the Tool Box tooltips. You can also hold Alt+Shift while pressing the
key, which is necessary when you are writing text (as the single key shortcuts will be disabled). For example, to select the brush, press **Alt+Shift+B** or just B (when not writing text).

- **Brush (B)**
- **Color Eraser (O)**
- **Color Picker (C)**
- **Connected Lines (N)**
- **Curve (V)**
- **Ellipse (E)**
- **Eraser (A)**
- **Flood Fill (F)**
- **Line (L)**
- **Pen (P)**
- **Polygon (G)**
- **Rectangle (R)**
- **Rounded Rectangle (U)**
- **Selection (Elliptical) (I)**
- **Selection (Free-Form) (M)**
- **Selection (Rectangular) (S)**
- **Spraycan (Y)**
- **Text (T)**

### 3.3 Brush

Click or click and drag with the brush to draw.

| ![Shapes] | Click on one of the shapes to select the brush shape. You can use a circular, square, slash or backslash brush shape. |

The left mouse button draws in the foreground color. The right mouse button draws in the background color.
3.4  **Color Picker**

To set the foreground color, left click on a pixel. To set the background color, right click on a pixel. KolourPaint will then return to the previously selected tool.

3.5  **Connected Lines and Polygon**

Click and drag to draw connected lines. The polygon tool is used in the same way, however, the start and end points are automatically connected to form a polygon.

The left mouse button draws in the foreground color. The right mouse button draws in the background color, and will also reverse the fill color for polygons.

You can set the line width. For polygons, you can also set the fill style.

3.6  **Curve**

Click and drag to draw a line - this sets the start and end points. You can set up to two control points by dragging. To finish the curve without using both or any control points, click the other mouse button. The curve tool draws a Cubic Bezier.

The left mouse button draws in the foreground color. The right mouse button draws in the background color.

You can also set the line width.

3.7  **Ellipse**

Click and drag to draw an ellipse.

The left mouse button draws in the foreground color. The right mouse button draws in the background color, and will reverse the fill color.

You can also set the line width and fill style.

For additional functionality, use the modifier keys:

- Hold **Shift** and drag to draw a circle.
- To draw an ellipse with a center point of your choice, hold **Ctrl**, click on the center point, and drag until the ellipse is the correct size and shape.
- To draw a circle with a center point of your choice, hold **Ctrl** and **Shift**, click on the center point, and drag until the circle is the correct size.

3.8  **Erasers**

3.8.1  **Eraser**

Click and drag with the eraser to rub out mistakes.
NOTE
Unlike other tools, the erasers draw in the background color. To draw in the foreground color, use the right mouse button.

The eraser only has square shapes. To draw with other shapes such as circles use the Brush and the right mouse button.

TIP
Double-click on the Eraser icon to clear the entire image. This is equivalent to using the Clear option on the Image menu.

3.8.2 Color Eraser

Click and drag to replace pixels of the foreground color with the background color. To replace all pixels similar (but not necessarily exactly equal) to the foreground color, such as in dithered images and photos, use a Color Similarity setting other than Exact.

NOTE
Unlike other tools, the erasers draw in the background color. To replace pixels of the background color with the foreground color, use the right mouse button.

You can configure the eraser size.

TIP
Double-click on the Color Eraser icon to apply it to the entire image.

3.9 Flood Fill

Click to fill a region. To fill a dithered region, use a Color Similarity setting other than Exact.

The left mouse button fills in the foreground color. The right mouse button fills in the background color.

3.10 Line

Click and drag to draw a line.

The left mouse button draws in the foreground color. The right mouse button draws in the background color.

You can also set the line width.
• Hold Ctrl to draw lines angled at the nearest multiple of 30 degrees - these are the lines in the red diagram.

• Hold Shift to draw lines angled at the nearest multiple of 45 degrees - these are the lines in the blue diagram.

• Hold Ctrl and Shift to draw lines angled at the nearest multiple of 30 or 45 degrees - these are the lines in the green diagram.

3.11 Pen

Click to draw a dot or click and drag to draw a freehand line.
The left mouse button draws in the foreground color. The right mouse button draws in the background color.

3.12 Rectangles

Click and drag to draw a rectangle. The Rounded Rectangle is a Rectangle with rounded corners. The left mouse button draws in the foreground color. The right mouse button draws in the background color, and will reverse the fill color.
You can also set the line width and fill style.
For additional functionality, use the modifier keys:

• Hold Shift and drag to draw a square.

• To draw a rectangle with a center point of your choice, hold Ctrl, click on the center point, and drag until the rectangle is the correct size and shape.

• To draw a square with a center point of your choice, hold Ctrl and Shift, click on the center point, and drag until the square is the correct size.

3.13 Selections

Use the selection tools to draw out the boundary of a selection.
To move the selection, click and drag on it. The main view will scroll as required to allow you to move the selection to part of the image that is not currently displayed.
You can free-form Resize the entire image or Smooth Scale the selection using the corresponding handles. Hold Shift while free-form scaling the selection to maintain aspect ratio. The right mouse button invokes a context menu with common Edit commands and Image Effects.

Tip
You can use the cursor keys while drawing out the boundary of the selection or while moving it.

If you hold Ctrl before moving the selection, then you will move a copy of it. The selection will be smeared when moving it while Shift is held.
There are two selection modes: Opaque (default) and Transparent. If you use the Transparent selection mode, all pixels of the background color will be transparent (background subtraction). This allows you to paste a selection without the background. To perform background subtraction on a dithered image, use a Color Similarity setting other than Exact.

You can apply Image Effects to a selection - see the Image Effects section for more information.

It is possible to save selection to file using the Copy to File... item from the selection context menu or Edit → Copy to File... item from the main menu.

### 3.14 Spraycan

Click and drag to spray graffiti. Hold down the mouse button for a more concentrated spray.

Click on one of the shapes to select the spray size. You can select from spray sizes of 9x9, 17x17 and 29x29.

The left mouse button draws in the foreground color. The right mouse button draws in the background color.

### 3.15 Text

Click and drag an area in which to write text. As soon as the border will be shown you can start writing the text. Click and drag on the border to move it. You can resize the text box by dragging on the handles or by using the Resize dialog.

**Tip**

If you have deselected a text box you can use Undo to edit the text again.
3.15.1 Using the Transparent Color

The left picture shows the example image. The right picture shows the addition of text with opaque foreground and background colors.

The left picture shows the addition of text with opaque foreground colors and a transparent background color. The right picture shows the addition of text with a transparent foreground color and opaque background color.

3.16 Common Tool Options

Click on one of the squares to select the eraser size. You can select from squares of side length 2, 3, 5, 9, 17 and 29 pixels. The eraser size setting affects the Erasers.
Click on one of the lines to select the line width. You can select from line widths of 1, 2, 3, 5 and 8 pixel(s). The line width setting affects the Connected Lines, Curve, Ellipse, Line, Polygon, Rectangle and Rounded Rectangle tools.

Click on one of the rectangles to select the fill style. You can select from No Fill, Fill with Background Color and Fill with Foreground Color. The fill style setting affects the Ellipse, Polygon, Rectangle and Rounded Rectangle tools.
Chapter 4

Working with Color

4.1 The Color Box

The Color Box has 3 main sections: the Color Tablet, the Color Palette and the Color Similarity Selector.

The Color Tablet shows the current foreground color as a square on top of another square representing the current background color. When drawing with the left mouse button, the foreground color is used, and when drawing with the right mouse button the background color is used (except for the Erasers). You can click on the double-ended arrow to swap the foreground and background colors.

The Color Palette shows a selection of colors for you to choose from. The translucent pyramid represents the transparent color. Left-click on a color to set the foreground color and right-click on a color to set the background color. You can also drag and drop any opaque color into the Color Tablet squares. To edit a color in the Color Tablet or Palette, double-click on it. The Color Picker tool allows you to select a color from the image.

Color Similarity allows you to work more effectively with dithered images and photos, in a comparable manner to the ‘Magic Wand’ feature of other paint programs. It applies to transparent selections, as well as the Flood Fill, Color Eraser and Autocrop / Remove Internal Border tools. Double-click on the Color Similarity Selector to choose how similar colors must be to be considered identical. When using selections in Transparent mode, any color in the selection that is similar to the background color will also be made transparent.

The left picture shows the example image. The right pictures demonstrate the use of a flood fill, with Color Similarity settings of 5%, 15% and 30%. In this example, with a Color Similarity setting of Exact, a flood fill at (80, 100) would only fill one pixel, as the surrounding pixels are similar but not identical. As Color Similarity is increased, more pixels that are similar in color are considered identical, hence the fill extends further.
Chapter 5

View Options

5.1 View Options Reference

Zoom incorporating the Grid
Thumbnail

5.2 Zoom incorporating the Grid

Increase the zoom level to edit images with more precision, or reduce it to see more of the image.

IMPORTANT
At zoom levels that aren’t multiples of 100%, parts of the image may appear to move when the user interacts with it. Other minor redraw glitches may also occur at such zoom levels.

At zoom levels of 400% or greater that are also multiples of 100%, you can Show Grid to more accurately edit individual pixels.

The first picture shows the Text tool icon, while the latter shows it at 600% zoom with the grid on.

Tip
Another way of zooming when not drawing is to scroll the wheel while holding Ctrl.
5.3 Thumbnail

If Zoomed Thumbnail Mode is selected, the entire image is displayed, scaled as required to fit the thumbnail window (top-right picture).

Otherwise, the thumbnail displays as much of the image as possible, starting from the top-left of the main view (bottom-right picture).
Chapter 6

Image Effects

6.1 Image Effects Reference

Autocrop / Remove Internal Border
Balance
Clear
Emboss
Flatten
Flip (upside down)
Invert
Reduce Colors
Reduce to Grayscale
Reduce to Monochrome (Dithered)
Mirror (horizontally)
Resize / Scale
Rotate
Set as Image (Crop)
Skew
Soften & Sharpen
More Effects
Notes

6.2 Autocrop / Remove Internal Border

This automatically removes the border of an image or selection. Use Autocrop if you have a figure that does not fill the entire image or selection and you wish to remove the excess whitespace. To use this feature with a dithered image border, you will also need to use Color Similarity.
6.3 Balance

This feature is accessible from the More Effects dialog.

![Balance dialog](image)

This allows you to set the brightness, contrast and gamma of the image or selection.

**NOTE**
The more common measure of gamma (a decimal from 0.10 to 10.00) is located between the Gamma spinbox and the Reset button.

6.4 Clear

This fills the entire image or selection with the background color.

**TIP**
Double-click on the Eraser icon to clear the entire image.

6.5 Emboss

This feature is accessible from the More Effects dialog.
The KolourPaint Handbook

Check **Enable** to apply the Emboss effect. This emphasises the edges and gives the image or selection an "engraved look".

### 6.6 Flatten

This feature is accessible from the **More Effects** dialog.

This recolors the image with varying shades of the two selected colors.
6.7 **Flip (upside down)**

This flips the entire image or selection vertically.

6.8 **Invert**

This feature is accessible from the More Effects dialog.

![More Image Effects dialog](image)

This allows you to invert one or more RGB channels in the image or selection. Select **All** to change a photo into a negative and vice versa. This generally looks quite funny.

**Tip**

To quickly invert all channels, you do not need to use this dialog. You can instead access the **Invert Colors** item in the Image or Selection menu. The **Selection** item is only displayed in the menubar if you use one of the selection tools. Additionally you can reach this action from the context menu opened with a right mouse button click in the image area.

6.9 **Mirror (horizontally)**

This mirrors the entire image or selection horizontally.

6.10 **Reduce Colors**

This feature is accessible from the More Effects dialog.
This reduces the number of colors used by the image or selection, with or without dithering. Dithering generally provides better quality results, however, you may wish to disable it for artistic effects; e.g. using Monochrome instead of Monochrome (Dithered) gives a silhouette effect.

Another important distinction is that while Monochrome (Dithered) will always reduce the entire image or selection to black and white, Monochrome will do this only if the image or selection contains more than 2 colors.

**TIP**
For a quick, dithered monochrome image or selection, use the Reduce to Monochrome (Dithered) item of the Image or Selection menu. The Selection item is only displayed in the menubar if you use one of the selection tools. Additionally you can reach this action from the context menu opened with a right mouse button click in the image area.

**NOTE**
Changing the number of colors here has no effect on the color depth of the file format. If you want to change the color depth, you should select it in the file saving dialogs. Note that, confusingly, changing the color depth also changes the number of colors.

### 6.11 Reduce to Grayscale

This reduces the entire image or selection to grayscale.

### 6.12 Reduce to Monochrome (Dithered)

This reduces the entire image or selection to black and white.
6.13 Resize / Scale

Resizing the image changes the dimensions of the image without applying a transformation to the existing contents. Scaling the image will stretch the existing contents to the new dimensions. **Smooth Scale** generally provides better quality results than Scaling, by blending neighbouring colors.

You can express the new dimensions in pixels, or as a percentage of the original size. If you select **Keep aspect ratio**, the width and height will be scaled by the same percentage.

**Tip**

You can free-form **Resize** the entire image or **Smooth Scale** the selection using the corresponding handles.

**Note**

Only scaling is supported for selections, and only resizing is supported for text boxes. See **Notes** for additional details about applying these effects.
6.14 Rotate

This rotates the image. You can specify the angle and direction of rotation.

**Tip**
You can reverse the direction of rotation by specifying a negative custom angle.

**Note**
See Notes for details about applying this effect to a selection.

6.15 Set as Image (Crop)

This will set the selection as the image.

**Note**
This is only available when you have an active selection.
6.16 Skew

This skews the entire image or selection horizontally and/or vertically.

**NOTE**
See Notes for details about applying this effect to a selection.

6.17 Soften & Sharpen

This feature is accessible from the More Effects dialog.
Use this effect to soften or sharpen the image.

### 6.18 More Effects

This dialog contains the **Balance**, **Emboss**, **Flatten**, **Invert**, **Reduce Colors** and **Soften & Sharpen** features.

### 6.19 Notes

**Resizing / Scaling**, **Rotating** and **Skewing** may change the dimensions of the image. You can view the new dimensions in the dialog.

If you apply these effects to an image, the image will be resized if necessary. However, if you apply these effects to a selection, the image will not be resized, even if the transformed selection does not fit.
The left image has been rotated 30 degrees clockwise to form the right image. KolourPaint has automatically enlarged the image to accommodate the larger contents.

The left selection has been rotated 30 degrees clockwise to form the right selection. The image size has remained the same, hence parts of the selection will not be visible without Resizing the image.
Chapter 7

Credits and License

It might not be concise documentation; it might not be complete documentation; but it is honest documentation.

—Carl Tucker

KolourPaint
Program Copyright (c) 2003, 2004, 2005 Clarence Dang dang@kde.org
KolourPaint-specific icons Copyright (c) 2004, 2005 Kristof Borrey borrey@kde.org, Nuno Pinheiro nf.pinheiro@gmail.com, Danny Allen dannya40uk@yahoo.co.uk
Documentation and additional documentation artwork Copyright (c) 2004, 2005 Thurston Dang thurston_dang@users.sourceforge.net
Portions reproduced with permission from http://kolourpaint.sourceforge.net/
This documentation is licensed under the terms of the GNU Free Documentation License.
This program is licensed as follows:
Copyright (c) 2003, 2004, 2005 Clarence Dang dang@kde.org

All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.